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SMT Installation

SMT is distributed as an add-on product for SUSE Linux Enterprise Server 10 SP2
system. To install it, install the SUSE Linux Enterprise Server 10 SP2 base system.
You can choose to install the SMT add-on together with your base system during the
initial installation process, or you can install the SMT add-on on top of an already in-
stalled base system at any later time.

1.1 Installation During the Initial
Installation Process

To install SMT add-on together with your base system during the initial installation
process, follow these steps:

1 Start SUSE Linux Enterprise Server 10 SP2 installation as usual. For more infor-
mation, see the SUSE Linux Enterprise Server documentation.

2 To include the SMT add-on product, check the Include Add-On Products from
Separate Media option in the Installation Mode dialog in the System Analysis
step and click Next.

3 In the next dialog, click Add and, if you are installing SMT from a CD medium,
select CD as the source type. If you are installing from a different source, such
as NFS or HTTP, choose the appropriate source type. Click Next.
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4 Ifyou are installing from CD, insert the SMT add-on product CD. If you are in-
stalling from a different source, provide the necessary source. Click Continue.

5 Confirm the SMT license agreement and click Next.

6 The SMT add-on product is displayed in the overview. Continue with the instal-
lation as usual. Make sure, that the SMT: Subscription Management Tool for SLE
installation pattern is selected automatically and do not remove it.

7 A two-step SMT Configuration Wizard is shown during the final steps of the in-
stallation workflow. Configure SMT as described in Section 1.3, “SMT Configu-
ration Wizard” (page 3) and continue with the SUSE Linux Enterprise Server
installation as usual.

1.2 Installation On Top of an Already
Installed System

To install SMT on top of an already installed base system, follow these steps:

1 Start YaST and select Software > Add-On Product.

2 Ifyou are installing SMT from a CD medium, select CD as the source type. If
you are installing from a different source, such as NFS or HTTP, choose the ap-
propriate source type. Click Next.

3 Ifyou are installing from CD, insert the SMT add-on product CD. If you are in-
stalling from a different source, provide the necessary source. Click Continue.

4 Confirm the SMT license agreement and click Next.
5 Click Accept to install the SMT: Subscription Management Tool for SLE pattern.

6 The SMT Configuration Wizard is launched. See Section 1.3, “SMT Configuration
Wizard” (page 3).
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1.3 SMT Configuration Wizard

During the installation of SMT the two-step SMT Configuration Wizard is launched,
irrespective of the used installation method. Configure SMT using this wizard. However,
you will be able to change the configuration later using the YaST SMT Configuration
module.

1 The Enable Subscription Management Tool service (SMT) option is checked by
default. Uncheck it only if you want to disable the installed SMT.

If the firewall is enabled, check Open Port in Firewall to allow access to the
SMT service from remote computers.

Enter your Novell Customer Center mirroring credentials in NU User and NU
Password. NU stands for Novell Update. If you do not know your Novell Cus-
tomer Center credentials, refer to Section 3.1, “Getting Mirror Credentials”
(page 13). Test the entered credentials by pressing the 7est button. SMT will
connect to the Customer Center server using the provided credentials and
download some testing data.

Enter the e-mail address you have used for the Novell Customer Center registra-
tion into NCC E-mail Used for Registration.

Your SMT Server URL should contain the URL of the SMT server being config-
ured. It is filled in automatically.

Press Next to continue to the second configuration step.

2 For security reasons, SMT uses a special user in the database. Set the SMT
Database Password in the respective fields. The password should not be empty.

Enter all e-mail addresses SMT should send reports to using the Add button. You
are also able to Edit or Delete any incorrect or needless addresses.

Press Next.

3 If the current MySQL root password is empty—as in any freshly installed sys-
tem— you will be asked to enter a New MySQL Root Password.
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Configuring SMT Using YaST

SMT can be activated and configured using a graphical interface. A special YaST
module has been created for this purpose. The YaST SMT Configuration module can
be used to configure mirroring credentials, SMT database passwords and e-mail address-
es to send SMT reports to, or to set the SMT job schedule, and activate or deactivate
the SMT service.

To configure SMT using the YaST SMT Configuration module, follow these steps:

1 To start YaST SMT module with text (ncurses) interface, run the yast smt
command as root.

To start the YaST SMT module with graphical interface, run yast2 smt as
root or open YaST Control Center and select SMT Configuration in the Network
Services section.

2 To activate SMT, check the Enable Subscription Management Tool Service
(SMT) option in the Customer Center Access tab. If you want to disable SMT,
uncheck this option. For more information about activating SMT using YaST,
see Section 2.1, “Activating and Deactivating SMT with YaST” (page 6)

3 In the Customer Center Access tab, set and test credentials for the NU (Novell
Update) service. Correct credentials are necessary to enable mirroring from NU
and determine the products that should be mirrored. Also set the e-mail address
used for the registration and the URL of your SMT server. For more information,
see Section 2.2, “Setting NU Credentials with YaST” (page 8).
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4 In the Database and Reporting tab, set the password for the SMT user in the
MySQL database and enter the e-mail addresses where reports should be sent to.
For more information, see Section 2.3, “Setting SMT Database Password with
YaST” (page 9) and Section 2.4, “Setting E-mail Addresses to Receive Reports
with YaST” (page 10).

5 In the Scheduled SMT Jobs tab, set a schedule of periodic SMT jobs, such as
synchronization of updates, Novell Customer Center registration, or SMT report
generation. For more information, see Section 2.5, “Setting the SMT Job
Schedule with YaST” (page 10).

6 If satisfied with the configuration, click Finish. YaST adjusts the SMT configu-
ration and starts or restarts necessary services.

If you want to abort the configuration and cancel any changes, click Abort.

NOTE

When the YaST SMT module applies configuration changes, it checks for
the existence of the common server certificate. If the certificate does
not exist, you will be asked whether the certificate should be created
and the YaST CA Management module will be started, if you approve.

2.1 Activating and Deactivating SMT
with YaST

YaST provides an easy way to activate or deactivate the SMT service. To activate SMT
service using YaST, follow these steps:

1 Open the Customer Center Access tab of the YaST SMT Configuration module.

2 Check the Enable Subscription Management Tool service (SMT) option.

NOTE

Note that if not already configured, mirroring credentials should be
configured before activating SMT. For more information about how to
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set mirroring credentials using YaST, see Section 2.2, “Setting NU Creden-
tials with YaST” (page 8).

3 Click Finish to apply the changes and leave YaST SMT Configuration module.

To deactivate SMT service using YaST, follow these steps:

1 Open the Customer Center Access tab of the YaST SMT Configuration module.
2 Uncheck the Enable Subscription Management Tool service (SMT) option.
3 Click Finish to apply the changes and leave YaST SMT Configuration module.

When activating SMT, the following important operations are performed by YaST:

+ The Apache configuration is changed by creating symbolic links in the /etc/
apache?2/conf .d/ directory. Linkstothe /etc/smt .d/nu_server.conf
and /etc/smt.d/smt_mod_perl.conf files are created there.

» The Apache Web server is started or reloaded if already running.

+ The MySQL server is started or reloaded if already running. If it does not exist,
smt user and necessary tables in the database are created.

» The schema of the SMT database is checked. If the database schema is obsolete,
the SMT database is upgraded to conform to the current schema.

+ Cron is adjusted by creating a symbolic link in the /etc/cron.d/ directory. A
link to the /etc/smt .d/novell.com-smt file is created there.

When deactivating SMT, the following important operations are performed by YaST:

+ Symbolic links created upon SMT activation in the /etc/apache2/conf.d/
and /etc/cron.d/ directories are deleted.

» The Cron, Apache Web and MySQL servers are reloaded. Neither Apache nor
MySQL are stopped, because they may be used for other purposes than the SMT
service.
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2.2 Setting NU Credentials with YaST

YaST provides a comfortable interface to set and test NU credentials and the URL of
the NU service. To do so, follow these steps:

Figure 2.1 Setting NU Credentials with YaST

Customer Center Df NU Configuration
Access
Enter the credentials for

Novell Updates (NU) here. Customer Center Access Database and Reporting Scheduled SMT Jobs

User and Password is
needed for Novell
Customer Center | Enable Subscription Management Teol Service (SMT)
authentication. To test the
credentials you entered,
click Test. SMT then Firewall is disabled
connects to the Customer
Center server for

authentication and VLR
download of test data 285740
E-mail should be the one NU Password
you used to register to [T

NCC

Firewall Settings

To open the firewall to
allow access to the service
from remote computers,
set Open Port in Firewall
This option is available user@example.com
only if the firewall is
enabled

Test

MNCC E-mail Used for Registration

Your SMT Server URL

http://smt. example.com/

Back Abort Finish

1 Open the Customer Center Access tab of the YaST SMT Configuration module.
If the credentials have been already set using YaST or the /etc/smt.conf
configuration file, they appear in the dialog. Otherwise, the NU User and NU
Password fields are blank.

2 Ifyoudo not have your credentials, visit Novell Customer Center to obtain them.
For more information, see Section 3.1, “Getting Mirror Credentials” (page 13).

3 Enter your NU username in NU User and the corresponding password in NU
Password.

4 Press Test to check the credentials. YaST will try to download a list of available
repositories using the provided credentials. If the test succeeded, the last line of
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the test results willread Test result: success. Ifthe test fails, check the
provided credentials and try again.

Figure 2.2 Succesful Test of NU Credentials

Test Details

Creating a temporary file..

Writing credentials to a temporary file..
Downloading list of available repositories. .
Checking list of downloaded repositories. .
Some repositories were found.

Test result: success

5 Enter the NCC E-mail Used for Registration. This should be the address you
used to register to Novell Customer Center.

Enter Your SMT Server URL if it has not been detected automatically.

6 Press Finish or continue with other configurations.

2.3 Setting SMT Database Password
with YaST

For security reasons, SMT uses its own user in the database. YaST provides a comfort-
able interface for setting up or changing the SMT database password. To set or change
the SMT database password using YaST follow these steps:

1 Open the Database and Reporting tab of the YaST SMT module.

2 Enter the SMT Database Password for smt User. Confirm the password by
reentering it and press Finish or continue with other configurations.
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2.4 Setting E-mail Addresses to
Receive Reports with YaST

YaST SMT Configuration module provides a comfortable interface for setting up a list
of e-mail addresses SMT reports will be sent to. To edit the list of addresses to receive
the reports, follow these steps:

1 Open the Database and Reporting tab of the YaST SMT Configuration module.

2 The list of e-mail addresses to send reports to is shown in the table. You can Add,
Edit, or Delete addresses using the respective buttons.

3 Press Finish or continue with other configurations.

The comma separated list of adresses SMT reports should be sent to is written to the
reportEmail option of the /etc/smt.conf configuration file.

2.5 Setting the SMT Job Schedule with
YaST

The YaST SMT Configuration module provides a comfortable interface to schedule
periodical SMT jobs. YaST uses cron to schedule configured jobs. If needed, cron
can be used directly. Three types of periodical jobs can be set:

Synchronization of Updates
Synchronizes with Novell Customer Center, updates catalogs, and downloads new
updates.

Report Generation
Generates and sends SMT reports to addresses defined in Section 2.4, “Setting E-
mail Addresses to Receive Reports with YaST” (page 10).

NCC Registration
Registers all clients to Novell Customer Center that are not already registered or
that changed their data since the last registration.
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Figure 2.3 Setting SMT Job Schedule with YaST

Editing a SMT Scheduled Job

Erequency Jobto Run
Pericdically |+ WNCC Registration hd
Job Start Time
Sunday - =
Ewery H-th Hour Ewvery M-th Minute
] = 15 =

Cancel

To configure the schedule of SMT jobs using YaST, follow these steps:

1 Open the Scheduled SMT Jobs tab of the YaST SMT Configuration module. The
table contains a list of all scheduled jobs, their type, frequency, date, and time
to run. You can add, delete or edit these scheduled events.

2 Ifyou want to add a scheduled SMT job, press Add. The Adding New SMT
Scheduled Job dialog opens.

Choose the synchronization job to schedule. You can choose between Synchro-
nization of Updates, Report Generation, and NCC Registration.

Choose the Frequency of the new scheduled SMT job. Jobs can be performed
Daily, Weekly, Monthly, or Periodically (every n-th hour or every m-th minute).

Set the Job Start Time by entering Hour and Minute. In case of periodical fre-
quency, enter the respective periods. For weekly and monthly schedules, select
Day of the Week or Day of the Month.

Press Add.

3 If you want to edit a scheduled SMT job, for example, change its frequency,
time, or date, select the job in the table and press Edit. Then change any parame-
ters as if you were creating a new schedule and press OK.
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4 If you want to cancel a scheduled job and delete it from the table, select the job
in the table and press Delete.

5 Press Finish to apply the settings and quit the YaST SMT Configuration module
or continue with other configurations.
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Mirroring Installation and
Update Sources Using SMT

SMT provides the possibility to mirror installation and update sources locally and to
bypass per-machine downloads and the bandwidth charges that go with it.

3.1 Getting Mirror Credentials

Before creating local mirrors of the repositories, you need to have proper mirror creden-
tials. You can get these credentials from the Novell Customer Center by following these
steps:

1 Visit Novell Customer Center at http://www.novell.com/center and
log in.

2 Click on My Products. The list of product families is shown.

3 Expand any product family by clicking on its name. You can also expand all
product families by clicking on the icon showing the arrow with two converse
arrowheads (with the Expand All Product Families tooltip). Products in the ex-
panded families are shown.

4 Double click on any specific product in the list to show detailed information
about the product.

5 In the Downloads section, click on the Mirror Credentials link.

Mirroring Installation and Update Sources Using SMT
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6 The credentials and mirror sites will be listed. These values are the same for all
users and subscriptions for a specific company.

Figure 3.1 NU Credentials in Novell Customer Center

Soubor Up\gvy Zobrazit Historie ZaloZky Nastroje Mapovéda
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htips:/inu.novell.comirepo/$RCE/SLE10-SDK-SP1-Online/
https:/inu.novell.comirepo/SRCE/SLET0-SDK-SP1-Updates/

hitps:/inu.novell.comirepo/$RCE/SLE10-SDK-SP2-Online/

Aecourt Rep
Customer Respanse https:/inu.novell.comirepo/SRCE/SLE10-5DK-SP2-Pool/
Center hitps:/inu.novell.comirepo/SRCE/SLE10-5DK-5P2-Updates/
[Send Email]
hitpsz/inu.novell.comirepo/SRCE/SLE10-SDK-Updates/
hitps:/inu.novell.comy E/SLET0-SP1 info-Updat
Seruice Rep
European Support Center  https:/inu.novell.comirepo/SRCE/SLE10-5P2 info-Updat
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The obtained credentials should be set in the YaST SMT module or manually written
inthe /etc/smt . conf file. For more information about configuring NU credentials
using YaST, see Chapter 2, Configuring SMT Using YaST (page 5). For more infor-

mation about the /etc/smt . conf file, see Section 6.2.1, “/etc/smt.conf” (page 37)

3.2 Managing Software Catalogs with
SMT

This section describes tools and procedures for viewing information about software
catalogs available through SMT, configuring these catalogs and setting new custom
catalogs.
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3.2.1 Updating the local SMT database

The local SMT database needs to be updated periodically with the information down-
loaded from Novell Customer Center. These periodical updates can be configured with
YaST SMT Configuration module, as described in Section 2.5, “Setting the SMT Job
Schedule with YaST” (page 10).

To update the SMT database manually, use the smt —ncc—sync command. For more
information about the smt—-ncc-sync command, see Section “smt-ncc-sync”

(page 33).

3.2.2 Enabled Catalogs and Catalogs that
Can Be Mirrored

The database installed with SMT contains information about all software catalogs
available on Novell Customer Center. However, the used mirror credentials determine
which catalogs can really be mirrored. For more information about getting and setting
mirror credentials, see Section 3.1, “Getting Mirror Credentials” (page 13).

The mirrorability of catalogs is determined by fetching ht tps://nu.novell.com/
repo/repoindex.xml using the provided mirror credentials. Catalogs that can be
mirrored have the MIRRORABLE flag set in the catalogs table in the SMT database.

The fact that a catalog can be mirrored does not mean that it has to be mirrored. Only
catalogs with the DOMIRROR flag set in the SMT database will be mirrored. For more
information about setting which catalogs should be mirrored, see Section 3.2.4, “Select-
ing Catalogs to be Mirrored” (page 16).

3.2.3 Getting Information About Catalogs

Use the smt-catalogs command to list available software catalogs and additional
information. Using this command without any options lists all available catalogs, in-
cluding catalogs that cannot be mirrored. In the first column, the enabled catalogs
(catalogs set to be mirrored) are marked with Yes. Disabled catalogs are marked with
No. The other columns show ID, type, name, target, and description of the listed catalogs.
The last column shows whether the catalog can be mirrored.

Mirroring Installation and Update Sources Using SMT
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Use the —verbose option, to get additional information as the source URL of the
catalog and the path it will be mirrored to.

The catalog listing can be limited to only catalogs that can be mirrored or to enabled
catalogs. To list only catalogs that can be mirrored, use the —m or
——only-mirrorable option: smt-catalogs -m.

To list only enabled catalogs, use the —o or ——only-enabled option:
smt-catalogs -o.

Example 3.1 Listing All Enabled Catalogs

tux:~

# smt-catalogs —o

| Mirror? | ID | Type | Name | Target

Can be Mirrored |

Description

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

Yes

SLES10-SP2-Online

sles-10-1586
sles-10-ia64
sles-10-ppc
sles-10-s390x
sles-10-x86_64
sles-10-1586
sles-10-ia64
sles-10-ppc
sles-10-s390x
sles-10-x86_64

SLES10-SP2-Online for sles-10-i586
SLES10-SP2-Online for sles-10-ia64
SLES10-SP2-Online for sles-10-ppc
SLES10-SP2-Online for sles-10-s390x
SLES10-SP2-Online for sles-10-x86_64
SLES10-SP2-Updates for sles-10-1586
SLES10-SP2-Updates for sles-10-ia64
SLES10-SP2-Updates for sles-10-ppc
SLES10-SP2-Updates for sles-10-s390x
SLES10-SP2-Updates for sles-10-x86_64

nu Yes

nu Yes
nu Yes
Yes
Yes

|
|
|
|
|
Yes |
|
|
|
|

SLES10-SP2-Updates Yes
SLES10-SP2-Updates
SLES10-SP2-Updates
SLES10-SP2-Updates

Yes

Yes

Yes

It is also possible to list only catalogs with a particular name or to show information
about a catalog with a particular name and target. To list catalogs with a particular
name, use the smt-catalogs catalog_name command. To show information
about a catalog with a particular name and target, use the smt-catalogs
catalog_name target command.

3.2.4 Selecting Catalogs to be Mirrored

Only enabled catalogs can be mirrored. In the database, the enabled catalogs have the
DOMIRROR flag set. Catalogs can be enabled or disabled using the smt-catalogs
script.

To enable one or more catalogs, follow these steps:

1 If you want to enable all catalogs that can be mirrored or just choose one catalog
from the list of all catalogs, run the smt-catalogs -e command.

You are able to limit the list of catalogs by using the respective options. To limit
the list to only catalogs that can be mirrored, use the —m option: smt-catalogs
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-m —e. To limit the list to only catalogs with a particular name, use the
smt-catalogs —-e catalog_name command. To list only a catalog with
a particular name and target, use the command smt-catalogs -e
catalog_name target.

If you want to enable all catalogs belonging to a certain product, use the
——enable-by-prod or —p option followed by the name of the product and,
optionally, its version, architecture, and release: smt—-catalogs -p
product[, version[, architecture[, release]]] .Forexam-
ple, to enable all catalogs belonging to SUSE Linux Enterprise Server 10 SP2
for PowerPC architecture, use the smt—-catalogs -p
SUSE-Linux-Enterprise-Server-SP2, 10, ppc command. The list
of known products can be obtained with the smt-1ist-products command.

2 If more than one catalogs is listed, choose the one you want to enable by speci-
fying its ID listed in the catalog table and pressing Enter. If you want to enable
all the listed catalogs, use a and press Enter.

To disable one or more catalogs, follow these steps:

1 If you want to disable all enabled catalogs or just choose one catalog from the
list of all catalogs, run the smt—catalogs -d command.

If you want to choose the catalog to be disabled from a shorter list, or if you want
to disable all catalogs from a limited group, you can use any of the available
options to limit the list of the catalogs. To limit the list to only enabled catalogs,
use the —o option: smt—catalogs —o —d. To limit the list to only catalogs
with a particular name, use the smt-catalogs -d catalog_name com-
mand. To list only a catalog with a particular name and target, use the
smt—-catalogs -d catalog name target command.

2 If more than one catalogs is listed, choose which one you want to disable by
specyfing its ID listed in the catalog table shown and pressing Enter. If you want
to disable all the listed catalogs, use a and press Enter.
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3.2.5 Mirroring Custom Catalogs

It is possible to mirror catalogs that are not available at the Novell Customer Center
—custom catalogs— using SMT. Use the smt —setup-custom-catalogs script
for this purpose. Custom catalogs can also be deleted.

To set up a custom catalog to be available through SMT, follow these steps:

1 If you do not know the ID of the product the new catalogs should belong to, use
smt-1list-products to get the ID. For the description of the
smt-1list-products, see Section “smt-list-products” (page 31).

2 Runthe smt-setup-custom-catalogs —-—productid product_id
—-—name catalog_name -—-exturl catalog_url command, where
product__idisthe ID of the product the catalog belongs to, catalog_name
represents the name of the catalog and catalog_url is the URL the catalog
is available at. In case the added catalog should be available for more than one
product, specify the IDs of all products that should use the added catalog.

For example, to set My Catalog available at
http://example.com/My_Catalog to the products with the IDs 423,
424, and 425, use the following command: smt-setup-custom-catalogs
——productid 423 —--productid 424 —--productid 425 —-name
'My_Catalog' —--exturl 'http://example.com/My_Catalog'.

NOTE: Mirroring Unsigned Catalogs

In its default configuration, SUSE Linux Enterprise 10 does not allow the use
of unsigned repositories. Therefore, if you want to mirror unsigned repositories
and use them on client machines, you have to allow this explicitly by executing
the following command on the client machines:

rug set security-level checksum

To remove an already set custom catalog from the SMT database, use
smt—-setup-custom-catalogs —-delete ID, where ID representsthe ID
of the catalog to be removed.
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3.2.6 Mirroring SUSE Linux Enterprise Server
9 Repositories

For mirroring old style update repositories which were used for SUSE Linux Enterprise
Server 9 and similar products, use a special command: smt-mirror—-sle9. This
script mirrors from the https://you.novell. com server.

The smt-mirror-sle9 script does not store information about sources to be mirrored
in the SMT database. It only uses the configuration from the /etc/smt . conf file.
The configuration of smt-mirror-sle9 is described in Section “smt-mirror-sle9
Sections of /etc/smt.conf” (page 41).

The smt-mirror-sle9 command uses wget to mirror sources. Therefore, you can
exclude anything you do not want to be mirrored by adding the
exclude_directories optionto the /root/.wgetrc configuration file. For
more information about wget and /root/.wgetrc,seeman 1 wget.

3.3 The /srv/www/htdocs Structure

The path to the directory containing the mirror is set by the MirrorTo option in the
/etc/smt.conf configuration file. For more information about /etc/smt . conf,
see Section 6.2.1, “/etc/smt.conf” (page 37). If the MirrorTo option is not set to the
Apache htdocs directory /srv/www/htdocs/, links should be created manually like
this: /srv/www/htdocs/repo/$RCE should pointto /MirrorTo/repo/SRCE/,
and /srv/www/htdocs/repo/RPMMD should point to /MirrorTo/repo/
RPMMD/. Here, /MirrorTo is the path set in the MirrorTo option.

For example, if the MirrorTo is setto /space/MIRRORDATA/:

srved:~ # 1 /srv/www/htdocs/repo/

insgesamt 16

drwxr-xr-x 2 root root 128 2008-01-18 14:00 ./

drwxr-xr-x 4 root root 128 2008-01-17 17:14 ../
lrwxrwxrwx 1 root root 27 2008-01-11 15:17 SRCE ->
/space/MIRRORDATA/repo/S$RCE/

-rw-r—--r—— 1 root root 14854 2008-01-21 12:36 repoindex.xml
lrwxrwxrwx 1 root root 26 2008-01-11 15:37 RPMMD ->
/space/MIRRORDATA/repo/RPMMD/

Mirroring Installation and Update Sources Using SMT
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The links can be created using the 1n -s command, for example: 1n -s
'/MirrorTo/repo/SRCE/"' '/srv/www/htdocs/repo/SRCE'

3.4 Using Test Environment

It is possible to mitror catalogs to a test environment instead of mirroring them the
production environment. The test environment can be used with a limited number of
client machines before the tested catalogs are moved to the production environment.
The test environment can be run on the main SMT server, no special server is needed
for that.

The testing evironment uses the same structure as the production environment, but it
is located in the /srv/www/htdocs/testing/ subdirectory.

To mirror to the testing environment, set the MirrorTo option in the /etc/smt
.conf file accordingly. If your standard mirror directory is located in the default
/srv/www/htdocs/ directory, set the MirrorTo to /srv/www/htdocs/
testing. For more information about the MirrorTo option and the /etc/smt
.conf file, see Section 6.2.1, “/etc/smt.conf” (page 37).

To register a client in the testing environment, modify the /etc/suseRegister
.conf on the client machine by setting:

register = command=register&testenv=1

To move the testing environment to the production environment, manually copy or
move it to the place of the production environment using the cp —a or mv command.
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Managing Client Machines
With SMT

SMT provides the possibility to register client machines on Novell Customer Center.
Client machines must be configured to be able to use SMT. For information about
configuring clients to be able to use SMT, see Chapter 7, Configuring Clients to Use
SMT (page 49).

4.1 Listing Registered Clients

To list client machines registered at SMT, use the smt-1ist-registrations
command. The following information is listed for each client: its Unique ID, Hostname,
date and time of Last Contact with the SMT server, and the Software Product the client
uses.

4.2 Deleting Registrations

To delete a registration from SMT and Novell Customer Center, use the
smt-delete-registrations -g Client_IDcommand. To delete multiple
registrations, the option —g can be used several times.

The ID of the client machine to be deleted can be determined from the output of the
smt-list-registrations command.

Managing Client Machines With SMT
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4.3 Manual Registration of Clients at
Novell Customer Center

The smt-register command registers clients at Novell Customer Center. All clients
that are currently not registered or whose data has changed since the last registration
are registered.

To register clients whose registration has failed, use the -—reseterror option. This
option resets the NCC registration error flag and tries to submit failed registrations
again.

4.4 Scheduling Periodic Registrations
of Clients at Novell Customer
Center

YaST SMT Configuration module allows easy scheduling of client registrations. In the
default configuration, registrations are scheduled to repeat every 15 minutes. To change
the frequency of registrations or to create a new registration schedule, follow these
steps:

1 Start YaST SMT Configuration module (yast2 smt).

2 Go to the Scheduled SMT Job.

3 Select any NCC Registration job and click Edit if you want to change its schedule.

To create a new registration schedule, click Add and select NCC Registration as
Job to Run.

4 Choose the Frequency of the scheduled SMT job. Jobs can be performed Daily,
Weekly, Monthly, or Periodically (every n-th hour or every m-th minute).

Set the Job Start Time by entering Hour and Minute, or, in case of periodical
frequency, the respective periods. For weekly and monthly schedules, select the
Day of the Week or the Day of the Month the mirroring should occur.
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NOTE: Lowest Registration Frequency

Do not set the frequency lower than 10 minutes, because the maximal
value of the rndRegister is 450 (7.5 minutes). If the frequency is
lower, it may occur that the started process is still sleeping when the next
process starts. In this case, the second request will exit.

5 Click either OK or Add and Finish.

You will find more information about the YaST SMT Configuration module in Chap-
ter 2, Configuring SMT Using YaST (page 5). Scheduling of SMT jobs in general is
covered in Section 2.5, “Setting the SMT Job Schedule with YaST” (page 10)

YaST uses cron to schedule Novell Customer Center registrations and other SMT
jobs. If you do not want to use YaST, you can use cron directly.

To disable automatic registration, change the forwardRegistration value in the
[LOCAL] section of the /etc/smt .conf configuration file to false.
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SMT Reports

SMT provides the possibility to generate reports based on SMT and Novell Customer
Center data. Generated reports contain statistics of the registered machines and products
used and of the active, expiring, or missing subscriptions. If the number of registered
machines and products exceeds the number of available subscriptions, warnings are
given.

NOTE: Assighment of Reports

If you are using more than one SMT server in your environment, generated
reports may not represent all of the SMT servers or machines in your environ-
ment. For the complete statistics of all your registered machines, refer to the
information in the Novell Customer Center.

5.1 Report Schedule and Recipients

Generated SMT reports can be sent to a defined list of e-mail addresses periodically.
To create or edit the list of e-mail addresses to send reports to, and to set the frequency
of the reports, use the YaST SMT Configuration module. How to configure the list of
addresses to send SMT reports to is described in Section 2.4, “Setting E-mail Addresses
to Receive Reports with YaST” (page 10). Configuration of the report schedule is de-
scribed in Section 2.5, “Setting the SMT Job Schedule with YaST” (page 10).

The list of e-mail addresses to send reports to can also be edited manually in the
reportEmail option ofthe /etc/smt . conf configuration file. For more informa-
tion about editing the list of addresses directly, see Section “[REPORT] Section of

SMT Reports

25



26

/etc/smt.conf” (page 40). To set the frequency of reports manually, you can directly
editthe /usr/1ib/SMT/bin/smt-gen-report line(s) of the crontabin /etc/
cron.d/novell.com-smt. For more information about the crontab format, see man
5 crontab.

Reports, including those created as a scheduled SMT job, are created by the

smt-report command. This command has various parameters. To edit parameters
used with scheduled commands, edit the /etc/smt .d/smt-cron.conf configu-
ration file. For more information, see Section 6.2.2, “/etc/smt.d/smt-cron.conf” (page 43).

5.2 Types of SMT Reports

Two types of reports can be created with the smt-report command:

——local
Ifthe ——1ocal option is used, the created report is based only on local SMT data.

——ncc
Ifthe ——ncc option is used, the created report is based on Novell Customer Center
data.

If neither ——1ocal nor ——ncc is used, the type of report is determined by the
forwardRegistrationinthe /etc/smt.conf configuration file. If the option
is setto true, the report is based on Novell Customer Center data. Ifitissetto false,
the report is based on local SMT data.

If you are creating a report based on local SMT data and you do not want local data to
be synchronized with the Novell Customer Center at all, use the —~—nonccsync option
together with ——1ocal option.

5.3 Report Output Formats and
Targets

SMT reports can be printed to the standard output, exported to one or multiple files (in
CVS format) as well as mailed to the defined list of e-mail addresses. Use the following
options for the smt—report command:
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—-—quiet or —-gq
Suppress output to STDOUT and run smt-report in quiet mode.

——fileor-F
Export report to one or several files. By default, the report will be written to a single
file rendered as tables. Optionally, the filename or whole path may be specified
after the parameter: ——file filename. Ifno filename is specified, a default
filename containing a timestamp is used. However, SMT will not check if the file
or files already exist.

In CSV (Comma-Separated Value) mode the report will be written to multiple files,
therefore the specified filename will expand to [path/
] filename-reportname.extension for every report.

——Csvor —c
The report will be exported to multiple files in CSV format. The first line of each
* csv file consists of the column names, the data starts on line two. The ——csv
parameter should only be used together with the ——£ i 1 e parameter. If the specified
filename contains . csv as extension, the report format will be CSV (as if the
——csv parameter was used).

—--mail or -m
Activate mailing of the report to the addresses configured with the YaST SMT
Configuration module and written in /et c/smt . conf. The report will be rendered
as tables.

-—attachor-a
Attach the report to the mails in CSV format. This option should only be used to-
gether with the ——ma il option.

NOTE: Disabling Sending Attachments

If you want to disable sending CSV attachments with report mails, edit the
/etc/smt.d/smt-cron.conf configuration file as follows: remove the
——attach option from the REPORT_PARAMS value. The default line reads:

REPORT_PARAMS="--mail --attach -L
/var/log/smt-report.log". To disable CSV attachments, change it to:
REPORT_PARAMS="--mail -L /var/log/smt-report.log".
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If you have disabled CSV attachments but need them occasionally, you can
send them manually with the smt-report --mail --attach -L
/var/log/smt-report.log command.
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SMT Tools and Configuration
Files

This chapter describes the most important scripts and configuration files shipped with
SMT.

6.1 Important Scripts and Tools

There are two important groups of SMT commands: The smt command with its sub-
commands is used for managing mirroring of updates, registration of clients, and report-
ing. The rcsmt script is used for starting, stopping, restarting SMT services, and for
checking their status.

6.1.1 /usr/sbin/smt Commands

The main command to manage the SMT is smt (/usr/sbin/smt). The smt com-
mand should be used together with various subcommands described in this section. If
the smt command is used alone, it prints out a list of all available subcommands. To
get help for individual subcommands, use smt subcommand —-help.

The following subcommands are available:
* smt-catalogs
* smt-delete-registration

* smt-list-products

SMT Tools and Configuration Files
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* smt-list-registrations

* smt-mirror

* smt-ncc-sync

* smt-register

e smt-report

* smt-setup-custom-catalogs
e smt-mirror-sle9

There are two syntax types you can use with the smt command: either use smt followed
by a subcommand or use a single command (composed of smt, dash, and the subcom-
mand of choice). For example, it is possible to use either smt mirror or
smt-mirror, both have the same meaning.

NOTE: Conflicting Commands

Depending on your SPATH environment variable, the SMT smt command
(/usr/sbin/smt) may collide with the smt command from the star package
(/usr/bin/smt). Either use the absolute path /usr/sbin/smt, create an
alias, or set your SPATH accordingly.

Another solution is to always use the smt-subcommand syntax (connected
with a minus sign) instead of smt subcommand (separated by a space).

smt-catalogs

The smt-catalogs (or smt catalogs) script can be used for listing all available
catalogs and for enabling or disabling catalogs. The following options are available:

——enable-mirror or —e
Enable catalog mirroring.

—-—enable-by-prodor -p
Enable catalog mirroring by giving product data in the following format:
Product[,Version[,Architecture[,Release]]].
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—-disable-mirror or -d
Disable catalog mirroring.

——only-mirrorable or -m
List only catalogs that can be mirrored.

—--only-enabledor -o
List only enabled catalogs.

—--verbose or -v
Show detailed catalog information.

smt-delete-registration

The smt-delete-registration command deletes one or more registrations
from SMT and Novell Customer Center. It will deregister machines from the system.
The following options are available:

-—guid IDor-g ID
Deletes the machine with the guid 7D from the system. This option can be used
multiple times.

——debug or -d
Enables debugging mode.

smt-list-products

The smt-1ist-products script lists all software products in the SMT database.
The following options are available:

——used or —u
Show only used products.

——catstator -c
Show whether all catalogs needed for a product are locally mirrored.
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smt-list-registrations

The smt-1list-registrations script lists all registrations. There are no options
available for this command.

smt-mirror

The smt —mirror command performs the mirroring procedure and downloads catalogs
that are set to be mirrored.

The smt-mirror command can be run with the following options:

——cleanor -c
Removes all files no longer mentioned in the metadata from the mirror. No mirroring
occurs before cleanup.

——debug or -d
Enables the debugging mode.

——deepverify
Turns on verifying of all package checksums.

——hardlink size
Searches for duplicate files with a size greater than the size specified in kilobytes.
Creates hard links for them.

——directory path
Defines the directory to work on. If you use this option, the default value configured
in the smt . conf configuration file is ignored.

——dbreplfile file
Defines the path to the *.xml file to use as database replacement. Such a file can
be created with the sync—ncc command. This option is only useful if the SMT
database is not located on the same host as the machine this script should run on.

—-—logfile fileor--L file
Specifies the path to a logfile.

Subscription Management Tool Guide



smt-ncc-sync

The smt-ncc-sync or smt ncc—sync command gets data from the Novell Cus-
tomer Center and updates the local SMT database. It can also save Novell Customer

Center data to a directory instead of the SMT database, or read Novell Customer Center
data from such a directory instead of downloading it from Novell Customer Center itself.

The smt-ncc-sync can be run with the following options:

——fromdir directory
Reads Novell Customer Center data from a directory instead of downloading it
from Novell Customer Center.

—-—todir directory
Writes Novell Customer Center data to the specified directory without updating
the SMT database.

——createdbreplacementfile
Creates a database replacement file for using smt-mirror without database.

—-logfile fileor—--L file
Specifies the path to a log file.

—-—debug
Enables debugging mode.

smt-register

The smt-register or smt register command registers all currently unregistered
clients at the Novell Customer Center. It also registers all clients whose data has changed
since the last registration.

The following options are available:

—-logfile fileor—-L file
Specifies the path to a log file.

——debug
Enables debugging mode.
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smt-report

The smt-report or smt report command generates a subscription report based
on local calculation or Novell Customer Center registrations.

The following options are available:

—-—local
Forces the creation of a report based on a local calculation without accessing
Novell Customer Center data.

——ncc
Forces the creation of a report based on Novell Customer Center data.

——nonccsync
Disables synchronizing with Novell Customer Center before creating the report.

—-mail or -m
Activates mailing the report to the addresses configured with the YaST SMT
Configuration module and written in /et c/smt . conf. The report will be rendered
as tables.

—-—attachor -a
Appends the report to the e-mails in CSV format. This option should only be used
together with the ——mail option.

——quiet or —g
Suppresses output to STDOUT and runs smt-report in quiet mode.

——Csv or —c
The report will be exported to multiple files in CSV format. The first line of each
* csv file consists of the column names, the data starts on line two. The ——csv
parameter should only be used together with the ——f i 1 e parameter. If the specified
filename contains . csv as extension, the report format will be CSV (as if the
——csv parameter was used).

—-—fileor-F
Exports the report to one or several files. By default, the report will be written to
a single file rendered as tables. Optionally, the filename or whole path may be
specified after the parameter: ——file filename.Ifno filename is specified,
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a default filename containing a timestamp is used. However, SMT will not check
if the file or files already exist.

In CSV mode the report will be written to multiple files, therefore, the specified
filename will expand to [path/] filename—reportname.extension for
every report.

—-—-logfile filenameor-L filename
Specifies path to a logfile.

—-—debug
Enables debugging mode.

smt-setup-custom-catalogs

The smt-setup-custom-catalogs or smt setup-custom-catalogs
script is a tool to set up custom catalogs (catalogs not present in NU) to be used with
SMT. It can be used for adding a new catalog to the SMT database or to delete a catalog
from the database. The script recognizes the following options:

——productid
ID of a product the catalog belongs to. If a catalog should belong to multiple
products, use this option multiple times to assign catalog to all relevant products.

——name
The name of the custom catalog.

—-—-description
The description of the custom catalog.

—-—exturl
The URL where this catalog can be mirrored from. Only HTTP and HTTPS proto-
cols are supported (no directory, file, or FTP).

-—-delete
Removes a custom catalog with a given ID from the SMT database.

To set up a new catalog, use the following command:

smt-setup-custom-catalogs —--productid Product_ID
——-name Catalog_Name --exturl URL
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For example:

smt-setup-custom-catalogs —--productid 434
—-—name My Catalog —--exturl http://my.domain.top/My_Catalog

To remove an already set catalog, use the following command:

smt-setup-custom-catalogs —--delete Catalog_ ID

For example:

smt-setup-custom-catalogs —--delete 1cf336d819e8e5904f4d4b05ee081971al0cc8afc

6.1.2 rcsmt Init Script

The rcsmt script starts, restarts, or stops SMT services. If used without any subcom-
mands, it returns a help text. The r csmt script can be used with the following subcom-
mands:

rcsmt start
Starts the SMT services.

rcsmt stop
Stops the SMT services.

rcsmt status
Checks the status of the SMT services. Checks whether httpd, MySQL, and cron
are running.

rcsmt restart
Restarts the SMT services.

rcsmt try-restart
Checks whether the SMT is enabled and if so, restarts the SMT services.

SMT services can also be enabled or disabled using the YaST SMT Configuration
module.
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6.2 SMT Configuration Files

The SMT has a main configuration file: /etc/smt . conf. Most of the options in this
file can be set using YaST SMT module (see Chapter 2, Configuring SMT Using YaST
(page 5)). Another important configuration fileis /et c/smt .d/smt—-cron.conf,
which contains parameters for commands launched as SMT scheduled jobs.

6.2.1 /etc/smt.conf

The /etc/smt.conf file has several sections. The [NU] section contains the NU
credentials and URL. The [DB] section contains the configuration of the MySQL
database SMT uses. The [LOCAL] section includes other configuration data. The
[REPORT] section contains the configuration of SMT reports. In the YOU9—* sections,
the configuration for the smt-mirror-sle9 command can be found.

WARNING

The /etc/smt.conf contains passwords in clear text and its default permis-
sions (640, root, wwwrun) make its content easily accessible with scripts running
on the Apache server. Be careful with running other software on the SMT
Apache server. The best policy is to use this server only for SMT.

[NU] Section of /etc/smt.conf

The following options are available in the [NU] section:

NUUr1l
URL of the NU service. In most cases, it should contain the
https://nu.novell.com/ URL.

NUUser
NUUser should contain the username for NU service. For information about getting
mirroring credentials, see Section 3.1, “Getting Mirror Credentials” (page 13).
This value can be set using YaST SMT Configuration module.
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NUPass
NUPass is the password for the user defined in NUUser. For information about
getting mirroring credentials, see Section 3.1, “Getting Mirror Credentials”
(page 13) This value can be set using the YaST SMT Configuration module.

[DB] Section of /etc/smt.conf

The three options defined in the [DB] section are used for configuring the database
SMT uses. Currently, only MySQL is supported by SMT.

config
The first parameter of the DBI->connect Perl method used for connection to the
MySQL database. The value should be in the form

dbi:mysqgl:database=smt;host=1ocalhost

where smt is the name of the database and 1 ocalhost the hostname of the
database server.

user
The user for the database. The default value is smt.

pass
The password for the database user. The password can be set using the YaST SMT
Configuration module.

[LOCAL] Section of /etc/smt.conf

The following options are available in the [LLOCAL] section:

url
The base URL of the SMT server which is used to construct URLs of the catalogs
available on the server. This value should be set by YaST automatically during in-
stallation. The format of this option should be:
https://server.domain.t1ld/.

The URL can be changed manually for various reasons. For example, the adminis-
trator may choose to use the http:// scheme instead of https: // for perfor-
mance reasons. Another reason may be using an alias (configured using CNAME
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in DNS) instead of the hostname of the server, for example
http://smt.domain.tld/insteadofhttp://serverl.domain.tld/.

nccEmail
E-mail address used for registration at the Novell Customer Center. This value can
be set using the YaST SMT Configuration module.

MirrorTo
Determines the path to mirror to.

MirrorAll
Ifthe MirrorAll option is set to true, the smt—ncc-sync script will set all
catalogs that can be mirrored to be mirrored (DOMIRROR flag).

MirrorSRC
If the MirrorSRC option is set to false, no source RPM packages are mirrored.

forwardRegistration
Determines whether the clients registered at SMT should be registered at Novell
Customer Center, too. If the forwardRegistration option is setto true,
client registrations will be forwarded to Novell Customer Center. If the
forwardRegistration optionissetto false, no client registrations will be
sent to Novell Customer Center.

rndRegister
Specifies a delay in seconds before registration of clients at Novell Customer
Center. The value is a random number between 0 and 450, generated by the YaST
SMT Configuration module. The purpose of this random delay is to prevent a high
load on the Novell Customer Center server that would occur if all smt-register
cronjobs connected at the same time.

HTTPProxy
If you do not want to use global proxy settings, specify the proxy to be used for
HTTP connection here. Use the following form:
http://proxy.example.com: 3128.

If the proxy settings are not configured in /et c/smt . conf, the global proxy
settings configured in /etc/syconfig/proxy are used. The global proxy
settings can be configured using the YaST Proxy module.

The HTTPProxy also applies to the smt-mirror-sle9 script.
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HTTPSProxy
If you do not want to use global proxy settings, specify the proxy to be used for
HTTPS connection here. Use the form: http://proxy.example.com: 3128.

If the proxy settings are not configured in /et c/smt . conf, the global proxy
settings configured in /etc/syconfig/proxy are used. The global proxy
settings can be configured using the YaST Proxy module.

The HTTPSProxy also applies to the smt-mirror—sle9 script.

ProxyUser
If your proxy requires authentication, specify a username and password here, using
the username: password format.

If the proxy settings are not configured in /et c/smt . conf, the global proxy
settings configured in /etc/syconfig/proxy are used. The global proxy
settings can be configured using the YaST Proxy module.

Neither the ProxyUser value nor the global proxy authentication settings apply
tothe smt-mirror-sle9 script. For user authentication in smt-mirror-sle9
write the following in the /root/ .wgetrc file: proxy_user=username
proxy_password=password.

[REPORT] Section of /etc/smt.conf

The following options are available in the [REPORT] section:

reportEmail
A comma separated list of e-mail addresses to send SMT status reports to. This list
can be set using YaST SMT Configuration Module.

reportEmailFrom
From field of report e-mails. If not set, the default
rootRhostname.domainname will be used.

mailServer
Relay mail server. If empty, e-mails are sent directly.

mailServerPort
Port of the relay mail server setinmailServer.
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mailServerUser
User name for authentication to the mail server set in mailServer.

mailServerPassword
Password for authentication to the mail server set in mailServer.

smt-mirror-sle9 Sections of /etc/smt.conf

Each product to be mirrored by the smt-mirror-sle9 command has a separate
predefined YOU9-* section in the /etc/smt . conf configuration file. /etc/smt
.conf is not configured via the SMT database like the smt-mirror command, all
configuration is contained in /etc/smt.conf.

mirror_prod
A product to be mirrored, for example Novell-Linux-Desktop.

mirror_archs
Comma separated list of architectures to be mirrored, for example 1386, x86_64.
Remove any architectures that do not need to be mirrored.

mirror_version
The version of the product to be mirrored, for example 9.

mirror
If you want to mirror this product, set mirror to true.

credentials
If you want to mirror this product, provide credentials in the user: password
format.

Example /etc/smt.conf
Example 6.1 config/smt.conf

[NU]

NUUrl = https://nu.novell.com/
NUUser = exampleuser

NUPass = examplepassword

[DB]
config = dbi:mysqgl:database=smt;host=1localhost
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user = smt
pass = examplepassword

[LOCAL]

# Default should be http://server.domain.top/

url = http://smt.example.com/

# This e-mail address is used for registration at NCC
nccEmail = exampleuser@example.com

MirrorTo = /srv/www/htdocs

MirrorAll = false

MirrorSRC = true

forwardRegistration = true

rndRegister = 91

# specify proxy settings here, if you do not want to use the global proxy
settings

#

# specify which proxy you want to use for HTTP connection
# in the form http://proxy.example.com:3128

HTTPProxy=

# specify which proxy you want to use for HTTPS connection
# in the form http://proxy.example.com:3128

HTTPSProxy=

# specify username and password if your proxy requires authentication
# in the form username:password

ProxyUser=

[REPORT]

# comma separated list of e-mail addresses where the status reports will be
sent to

reportEmail =

# from field of report mails - if empty it defaults to
"root@<hostname>.<domainname>"

reportEmailFrom =

# relay mail server - leave emtpy if mail should be sent directly
mailServer =

mailServerPort =

# mail server authentication - leave empty if not required
mailServerUser =

mailServerPassword =

[YOU9-Novell-Linux-Desktop]
mirror_prod = Novell-Linux-Desktop

mirror_archs = i1386,x86_64
mirror_version = 9

mirror = false

credentials =

[YOU9-Novell-Linux-Desktop—-SDK]
mirror_prod = Novell-Linux-Desktop-SDK

mirror_archs = 1i386,x86_64
mirror_version = 9

mirror = false

credentials =

42 Subscription Management Tool Guide



[YOU9-Novell-Linux-P0OS]
mirror_prod = Novell-Linux-POS

mirror_archs = 1386
mirror_version = 9
mirror = false
credentials =

[YOU9-Open-Enterprise-Server]
mirror_prod = Open-Enterprise-Server
mirror_archs = i386

mirror_version = 9

mirror = false

credentials =

[YOU9-SLES—-SDK]

mirror_prod = SLES-SDK

mirror_archs = i386,1a64,ppc,s390,s390x,x86_64
mirror_version = 9

mirror = false

credentials =

[YOU9-SUSE-CORE]

mirror_prod = SUSE-CORE

mirror_archs = i386,1ia64,ppc,s390,s390x,x86_64
mirror_version = 9

mirror = false

credentials =

[YOU9-SUSE-SLES]

mirror_prod = SUSE-SLES

mirror_archs = i386,1ia64,ppc,s390,s390x,x86_64
mirror_version = 9

mirror = false

credentials =

6.2.2 /etc/smt.d/smt-cron.conf

The /etc/smt .d/smt—-cron. conf configuration file contains options of the SMT
commands launched as SMT scheduled jobs set using YaST (see Section 2.5, “Setting
the SMT Job Schedule with YaST” (page 10)). Cron is used to launch these scheduled
jobs. The crontable is located in the /etc/cron.d/novell.com-smt file.

NCC_SYNC_PARAMS
Contains parameters of the smt ncc-sync command, if called as a part of an
SMT scheduled job via cron. The default value is "-L
/var/log/smt—-ncc-sync.log".
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MIRROR_PARAMS
Contains parameters of the smt mirror command, if called as a part of an SMT
scheduled job via cron. The default value is "-L
/var/log/smt-mirror.log".

REGISTER_PARAMS
Contains parameters of the smt register command, if called as a part of an
SMT scheduled job via cron. The default value is "-r -L
/var/log/smt-register.log".

REPORT_PARAMS
Contains parameters of the smt report command, if called as a part of an SMT
scheduled job via cron. The default value is "--mail --attach -L
/var/log/smt-report.log".

6.3 Server Certificates

For communication between the SMT server and client machines, the encrypted HTTPS
protocol is used, requiring a server certificate. If the certificate is not available, or if
clients are not configured to use the certificate, the communication between server and
clients will fail.

Every client must be able to verify the server certificate by trusting the CA (certificate
authority) certificate which signed the server certificate. Therefore, the SMT server
provides a copy of the CA at /srv/www/htdocs/smt.crt. This CA can be
downloaded from every client via the URL http://FODN/smt .crt. The copy is
created when YaST writes the SMT configuration. Whenever SMT is started with the
rcsmt init script, it checks the certificate. If a new CA certificate exists, it is copied
again. Therefore, whenever the CA certificate is changed, restart SMT using the rcsmt
restart command.

When the YaST SMT module applies configuration changes, it checks for the existence
of the common server certificate. If the certificate does not exist, YaST asks whether
the certificate should be created. If the user confirms, the YaST CA Management
module is started.
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6.3.1 Certificate Expiration

The common server certificate SMT uses is valid for one year. After that time, a new
certificate is needed. Either generate a new certificate using YaST CA Management
module or import a new certificate using the YaST Common Server Certificate module.
Both options are described in the following sections.

As long as the same CA certificate is used, there is no need to update certificates at the
client machines. The generated CA certificate is valid for 10 years.

6.3.2 Creating a New Common Server
Certificate

To create a new common server certificate with YaST, proceed as follows:

1 Start YaST and select Security and Users > CA Management. Alternatively,
start the YaST CA Management module from a command line by entering
yast2 ca_mgmas root.

2 Select the required CA and click Enter CA.

3 Enter the password if entering a CA for the first time. YaST displays the CA
key information in the Description tab.

4 Click the Certificates tab (see Figure 6.1, “Certificates of a CA” (page 46))
and select Add > Add Server Certificate.
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Figure 6.1 Certificates of a CA

First, see alist view with all Certificate Authority (CA)
available certiicates from this
CA.The columns are the DN of
the certificates including the CA Name: example-cert

&-mail address and the state of

the ceriificate (such as valid or Description | Cerlificaies | GAL | Requests

revoked)

R 0 GRS Status | Gommen Name | E-Mail Address | Organization | Organizational Unit | Locality | St
and execute some actions.

View opens a window with a text
representation of the complete
cerficate.

Furthermore, you can Revoke, « <|»
Delete, or Expori a cetificate.

With Add, generate a new
server or client eertificate.

In the area below, see the most
important values of the selected
certificate.

Back

5 Enter the fully qualified domain name of the server as Common Name. Add
a valid e-mail address of the server administrator. Other fields, as Organization,
Organizational Unit, Locality, and State are optional. Click Next to proceed.

IMPORTANT: Hostname in Server Certificate

The server certificate must contain the correct hostname. If the client
requests server https://some.hostname/, then some.hostname
must be part of the certificate. The hostname must either be used as
the Common Name, see Step 5 (page 46), or as the Subject Alternative
Name, see Step 7 (page 46):DNS: some . hostname and/or
IP:<ipaddress>.

6 Enter a Password for the private key of the certificate and reenter it in the next
field to verify it.

7 If you want to define a Subject Alternative Name, click Advanced Options,
select Subject Alternative Name from the list and click Add to enter the details
for the Subject Alternative Name.
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8 If you want to keep the default values for the other options, like Key Length
and Valid Period, click Next. An overview of the certificate to be created is
shown.

9 Click Create to generate the certificate.

10 To export the new certificate as the common server certificate, select it in the
Certificates tab and select Export > Export as Common Server Certificate.

11 After having created a new certificate, restart SMT using the rcsmt
restart command. Restarting SMT ensures that the new certificate is copied
from /etc/ssl/certs/YaST-CA.pemto /srv/www/htdocs/smt
.crt, the copy SMT uses. Restarting SMT also restarts the Web server.

For detailed information about managing certification and further usage of the YaST
CA Management module and the Common Sever Certificate module, refer to the /nstal-
lation and Administration.

6.3.3 Importing a Common Server
Certificate

You can import an own common server certificate from a file. The certificate to be
imported has to be in the PKCS12 format with CA chain. Common server certificates
can be imported with the YaST Common Server Certificate module.

To import an own certificate with YaST, proceed as follows:

1 Start YaST and select Security and Users > Common Server Certificate. Alterna-
tively, start the YaST Common Server Certificate module from the command
line by entering yast2 common_cert as root.

The description of the currently used common server certificate is shown in the
dialog that opens.

2 Click Import and select the file containing the certificate to be imported. Specify
the certificate password in the Password field.

3 Press Next. If the certificate is successfully imported, close YaST with Finish.
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4 After having created a new certificate, restart SMT using the rcsmt restart
command. Restarting SMT ensures that the new certificate is copied from /etc/
ssl/certs/YaST-CA.pemto /srv/www/htdocs/smt.crt, the copy
SMT uses. Restarting SMT also restarts the Web server.

6.3.4 Synchronizing Time Between SMT
Server and Clients

There is no need for a precise synchronization of time between the SMT server and
clients. However, each server certificate has a validity period and if the client happens
to be set to a time outside of this period, the certificate validation on the client side fails.

Therefore, it is advisable to keep the time on the server and clients synchronized. You
can easily synchronize time using NTP (network time protocol). Use yast 2
ntp-client to configure an NTP client. You will find detailed information about
NTP in Installation and Administration.
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Configuring Clients to Use
SMT

Any machine running SUSE Linux Enterprise SP2 or later can be configured to register
against SMT and download software updates from there instead of communicating di-
rectly with the Novell Customer Center and the NU servers.

If your network includes an SMT server to provide a local update source, you need to
equip the client with the server's URL. As client and server communicate via the HTTPS
protocol during registration, you also need to make sure the client trusts the server's
certificate. In case you set up your SMT server to use the default server certificate, the
CA certificate will be available on the SMT server at http://FQODN/smt .crt . In
this case you do not have to care about the certificate: The registration process will
automatically download the CA certificate from there, unless configured otherwise.
You have to enter a path to the server's CA certificate if the certificate was issued by
an external certificate authority.

NOTE: Registering Against * .novell.com Subdomain

If you try to register against any * .novell.com subdomain, the certificate
will not be downloaded during registration for security reasons, and certificate
handling will not be done. In such a case, use a different domain name or a
plain IP address.

There are several ways to provide this information and to configure the client machine
to use SMT. The first way is to provide the needed information via kernel parameters
at boot time. The second way is to configure clients using an AutoYaST profile. There
is also a script, clientSetup4SMT. sh, which can be run on a client to make it
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register against a specified SMT server. These methods are described in the following
sections:

7.1 Using Kernel Parameters to Access
an SMT Server

Any client can be configured to use SMT by providing the following kernel parameters
during machine boot: regurl and regcert. The first parameter is mandatory, the
latter is optional.

regurl
URL of the SMT server. The URL needs to be in the following format:
https://FQODN/center/regsvc/ with FODN being the fully qualified
hostname of the SMT server. It must be identical to the FQDN of the server certifi-
cate used on the SMT server. Example:

regurl=https://smt.example.com/center/regsvc/

regcert
Location of the SMT server's CA certificate. Specify one of the following locations:

URL
Remote location (http, https or ftp) from which the certificate can be download-
ed. Example:

regcert=http://smt.example.com/smt.crt

Floppy
Specifies a location on a floppy. The floppy has to be inserted at boot time—you

will not be prompted to insert it if it is missing. The value has to start with the
string £ 1oppy, followed by the path to the certificate. Example:

regcert=floppy/smt/smt-ca.crt

Local Path
Absolute path to the certificate on the local machine. Example:

regcert=/data/inst/smt/smt-ca.cert
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Interactive
Use ask to open a pop-up menu during installation where you can specify the
path to the certificate. Do not use this option with AutoYaST. Example:

regcert=ask

Deactivate Certificate Installation
Use done if either the certificate will be installed by an add-on product, or if
you are using a certificate issued by an official certificate authority. Example:

regcert=done

WARNING: Beware of Typing Errors

Make sure the values you enter are correct. If regurl has not been specified
correctly, the registration of the update source will fail.

If a wrong value for regcert has been entered, you will be prompted for a
local path to the certificate. In case regcert is not specified at all, it will default
to http://FQODN/smt.crt with FQDN being the name of the SMT server.

WARNING: Change of SMT Server Certificate

If the SMT server gets a new certificate from a new and untrusted CA, the
clients need to fetch the new CA certificate file. This is done automatically with
the registration process but only if a URL was used at installation time to fetch
the certificate, or if the regcert parameter was omitted and thus, the default
URL is used. If the certificate was loaded using any other method, such as
floppy or local path, the CA certificate will not be updated.

7.2 Configuring Clients Using
AutoYaST Profile

Clients can be configured to register with SMT server via AutoYaST profile. For gen-
eral information about creating AutoYaST profiles and preparing automatic installation,
refer to Installation and Administration. In this section, only SMT specific configuration
is described.
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To configure SMT specific data using AutoYaST, follow these steps:

1 As root, start YaST and select Miscellaneous > Autoinstallation to start the
graphical AutoYaST front-end.

From a command line, you can start the graphical AutoYaST front-end with the
yast2 autoyast command.

2 Open an existing profile using File > Open, create a profile based on the current
system's configuration using Tools > Create Reference Profile, or just work with
an empty profile.

3 Select Software > Novell Customer Center Configuration. An overview of the
current configuration is shown.

4 Click Configure.

5 Set the URL of the SMT Server and, optionally, the location of the SMT Certifi-
cate. The possible values are the same as for the kernel parameters regur 1 and
regcert (see Section 7.1, “Using Kernel Parameters to Access an SMT Server”
(page 50)). The only exception is, that the ask value for regcert does not
work in AutoYaST, because it requires user interaction. If using it, the registration
process will be skipped.

6 Perform all other configuration needed for the systems to be deployed.

7 Select File > Save As and enter a filename for the profile, such as autoinst
.xml.

7.3 Configuring Clients Using the
clientSetup4SMT.sh Script

The /usr/share/doc/packages/smt/clientSetup4SMT. sh script is
provided with SMT. This script allows to configure a client machine to use a SMT
server or to reconfigure it to use a different SMT server.

To configure a client machine to use SMT with the clientSetup4SMT. sh script,
follow these steps:
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1 Copy the /usr/share/doc/packages/smt/clientSetup4SMT. sh
script at your SMT server to the client machine.

2 As root, execute the script on the client machine. The script can be executed
in two ways. In the first case, the script name is followed by the registration URL:
./clientSetup4SMT.sh registration_URL, for example,
./clientSetup4SMT.sh
https://smt.example.com/center/regsvc. In the second case, the
script name is followed by the ——host option followed by hostname of the SMT
server: . /clientSetup4SMT.sh —-host server._ hostname, for ex-
ample, . /clientSetup4SMT.sh —--host smt.example.com.

3 The script downloads the server's CA certificate. Accept it by pressing y.

4 The script performs all necessary modifications on the client. However, the reg-
istration itself is not performed by the script.

5 Perform a registration by executing suse_register or running yast2
inst_suse_register module on the client.

The clientSetup4SMT. sh script works with SUSE Linux Enterprise 10 SP1 and
SP2 systems.

7.4 Registering Clients Against SMT
Test Environment

To configure a client to register against the test environment instead the production
environment, modify /etc/suseRegister.conf onthe client machine by setting:

register = command=registers&testenv=1

For more information about using SMT with a test environment, see Section 3.4, “Using
Test Environment” (page 20).
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